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ABSTRACT

This research is a study of photogrammetry techniques from unmanned aerial
vehicles to assess the amount of carbon sequestration from the teak area. The correlation
between the height of teak trees from unmanned airplanes and the height of teak trees
was investigated in Wangthong district, Phitsanulok to estimate the amount of carbon
sequestration from the plantation area. The accuracy between the height of teak from
unmanned aircraft and the height of teak from the field. And to estimated the diameter of
the chest using height data from the DSM, DEM, Orthophoto, and 3D models. The results
of aerial photos from unmanned aircraft found that the relationship between the height of
the teak from the unmanned aircraft and the height of the teak from the field has show well
correlation. The correlation coefficient was 0.97 and the mean square error (RMSE) of the
unmanned aerial altitude and field height was + 0.51 m. Tactile has an above ground
biomass of about 171,985.68 kg and a carbon capture capacity of 85,992.84 kg. This
plantation is also capable of absorbing carbon dioxide approximately 31,533.57 kilograms

per year.
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General workflow
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New Project X

This wizard creates a new project.
a name, a directory location and a type for your new project.
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Create In: |C/Users/Acer/Documents/piad Browse...

Froject Type

@ New Project
(O Project Merged from Existing Projects
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New Project X

Select Images

@ Enough images are selected: press Next to proceed.

90 image(s) selected. Add Images... |Add Directories...  Add Video...  Remove Selected| = Clear List
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E:/teak/Teak_1/Picture/DJI_0838.JPG
E:/teak/Teak_1/Picture/DJI_0839.JPG
E:/teak/Teak_1/Picture/DJI_0840.PG
E:/teak/Teak_1/Picture/DJI_0841.JPG
E:/teak/Teak_1/Picture/DJI_0842.JPG
E:/teak/Teak_1/Picture/DJI_0843.JPG
E:/teak/Teak_1/Picture/DJI_0844.JPG

£:ftosk/Mask 1/Dictira ML NAAS IDA

Help < Back I Next > I cancel

AN 3.5 N1FULAIAINENE

v




New Project %
Image Properties

Image Geolocation
Coordinate System

@ @ Datum: World Geodetic System 1984; Coordinate System: WGS 84 (EGM 96 Geoid)
Geolocation and Orientation

@ Geolocated Images: 90 out of 90 Clear From EXIF | | From File... To File...

Geolocation Accuracy: @ Standard (O Low () Custom

Selected Camera Model

@ B FC6310_8.8_5472x3648 (RGB) Manage camera model,

Eabled Image Group ade | londde | At o
DJI_0826JPG group 16.84361256 100.57568542 117.653
DJI_0827.JPG group 16.84355292 10057572964 117.753
DJI_0828JPG groupl 16.84350128 10057577950 117.753

DJI_0829.JPG groupl 16.84344542 100.57582992 117.753

(!7\ DJI 0830JPG aroup 16.84339017 100.57587939 117.753 5 v

Help < Back I Next > I Cancel

NN 3.6 TAYANINAEUARSNIN

New Project X
Select Output Coordinate System
Selected Coordinate System

Datum: World Geodetic System 1984
Coordinate System: WGS 84 / UTM zone 47N (EGM 96 Geoid)

Output/GCP Coordinate System
Unit: 'm ~
Arbitrary Coordinate System [m’

@) Auto Detected:  WGS 84 / UTM zone 47N

() Known Coordinate System [m]
Q

[] Advanced Coordinate Options

Help < Back Cancel
AN 3.7 NULINAIWENE
New Project X
Processing Options Template
Standard 3D Maps =
3D Maps
— Generate a DSM and an orthomosaic for mapping applications
Ag Multispectral Image Acquisition
Rapid ||= nadir flight ~ oblique flight
3D Maps - Rapid/Low Res o
3D Models - Rapid/Low Res Outputs Quality/Reliabilty
Ag Modified Camera - Rapid/L¢ Low Hi
Ag RGB - Rapid/Low Res _
@  Processing Speed
Advanced o—
Ag Modified Camera Slow Fas}
Ag RGB

Input Image Recommendations

Thermal Camera ®
Aerial images acquired using a grid fight plan with high overlap,
ThermoMAP Camera mostly oriented towards the ground

Qutputs Generated
Orthomosaic

[[] start Processing Nows

Help < Back Cancel

AN 3.8 NTULINAINANE
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3.3.2 Msuandulaya
o ng// 4

“inisuandudaya Point Cloud Taa'ld#l Proess > Run Point Cloud
Classification tHauenuiaazlAdus19 A9l Ground, Road Surface, High Vegetation,

Building #&% Human Made Object (A3n1w 3.9) Tuanuddedl fadudiasnislideyanumu

WIBULILANAa9ANNGINNLse AT e (Digital Terrain Model, DTM)UWAZIULIANABIAIIHN

1 2
a

qaavtnAquivuiaLEgLae ( Digital Surface Model, DSM) e tin LA ssnauuuanaas
AINNGINTINH (Canopy height model, CHM) Tneinasasaandeyaiiu Aana919 Point
Clouds > Export Point Clouds a1niiiaanianiziudaya Ground uaiaanuiuana wailu

.Las

¥ Layers

AW 3.9 Tudaya Point Cloud

3.3.3 msudasiayaningae

a4z o s .

\Hadeaandudieya Ground NHwNanaLlu LAS udatiu i91fieanisutlasivld .LAS
AWV Raster Tnensziounisantisay1dlilsunsa ArcGlS Tunisilszunanadioya Bu

AINNN9E374 Las dataset Wia 1 miuamiuiudiaya Point Cloud Naglugtluuy LAS files

k1l

TaspanaanInataas > New > Las dataset Lﬁ@iéﬁsﬁu%]mg@ Las dataset k&29111114651

v
v Y 4

fasnisiindudeyaiinly Inemdanuan® Las dataset > Properties > LAS File > Add File

U

A
o 4

wannNd Nt udana Ground.Las (9NN 3.10) A1NWWAANT Statistics > Calculate LN

a

ANUIRIANATIATB9TBYA Point Cloud (AININ 3.11)



LAS Dataset Properties

Gsnaruﬂacs Conshiaints Staisics XY Coordinale System 2 Coordinate System

Shove: Flle | (] Show full path of LAS files
LAS File Version  Foint Count  Foint Spacing Zuin ZMax Statistics
PC_Ground.las 12 1,854,137 0093 13165 AMATS

Remave

- fodrelers.

oK Cancel

X

Apply

29

LAS Dataset Properties x
General LASFiles Surface :msnsm-«mminm System  Z Coordingte System
Returns Attributes
Retum Foint Count % ZMin ZMax tame i ax &
Unknove 1854137 100.00 1207 48 Return . ] 0
Last 1854137 10000 1347 448 Intensity o o
Al 1899137 100.00 1317 W48 class code 2 2
Scan Angle om0 0000
User Data 0 0
Faint Source a 0
Red 0 &m0 v
Ciassification Codas
Classifcation Polnt Count “ ZMin ZMex Mindnte.. MaxIn. Synthet...
2 Ground L8137 100.00 13.17 4448 ] [ 0
Ciassifcation Fiags
Name Foint Caunt % jpdate [Ororce recaloulate
Model Key o oo
Synthetic o oo Statistics up to date
Overlap o oo
‘Withheld o oo
coe | [ rowy

AW 3.10 nMsudnTuaya Ground.Las WAENANISATNIMAEDALDITAYA Point
Cloud

ansunINsulasIng LAS Wiilulna Raster Tasl Search > Agaaila Las dataset

to Raster a1n%u Input LAS Dataset tiluds Ground.lasd iaaniifiukazmAeAn Sampling

Value Winfiy 0.1 (A9AINW 3.11)

‘\\ LAS Dataset to Raster

- m}

X

Input LAS Dataset
' Ground lasd

| (=]

Output Raster

| C:\Users\Acer\Documents\ArcGIS\Defautt.gdb\Ground_LasDa2

=)

Value Field (optional)

[EcevaTiOn

Interpolation Type (optional)
@ Binning

Cell Assignment Type (Optional)
AVERAGE -

Void Fill Method (Optional)
LINEAR ~

() Triangulation
Interpolation Method (Optional)
LINEAR
Faint Thinning Type (Optional)
NO_THINNING

Point Selection Method (Optionl)
MAXIMUM

Resalution (Optional)

Output Data Type (optional)
FLOAT

Sampling Type (optional)

[cerisze

Sampling Value (optional)

Z Factor (optional)

I 0K I Cancel

Environments...

<< Hide Help

Sampling Value
(optional)

Specifies the value used in
conjunction with the Sampling
Type to define the resolution of
the output raster

Toal Help

¥
o

NN 3.11 NNSAIATLATAINE LU Las dataset to Raster
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3.3.4 NSASNULLIRBIANNFINTINN

v
al o

TuduneUBEISEABINITLLLAIABIAIINGINIINY (Canopy height model, CHM)

|
|

WaldlszunAiaonngeaesiudnignanisaiuans (Aanw 3.12) Geadeldirsaciie

Raster Calculator 1uT1sunsu ArcGIS Tunisanuans Taendnlii Search > ipsasia Raster

Calculator > ldfuiiayan1ugns (AN 3.13)

DSM (Digital Surface Model)

Canopy Height Model.

CHM = DSM - DTM

NN 3.12 gmmeﬁﬂmm CHM (131 : www.researchgate.net)

#, Raster Caleulator - [m] X
© Map Algebra expression Map Algebra expression
Layers and varia.. * Conditional — ~ The Map Algebra expression you
want to run_
<> zonal_pteakL Con
==
<> zanal_pteakz AN [N R & pick The expression is composed by
2onal Setull specifying the inputs, values,
g h 4156 = > [|>=|| 1 operators, and tools to use. You
ortho Math can type in the expression
<> zonal_teaks 1 2] 3 - < ||<=|| ~ || abs directly or use the buttons and
& zonal_teaka o controls to help you create it.
<> zonal_teaki 0 2 + =
Y N ap Exp10 v « The Layers and variables
list identifies the datasets
“dsm.tif - DT available to use in the
Map Algebra expression.
Output raster
C:\Users\Acer\Documents\ArcGIS\Default.gdb\rastercalcz ]
pr
« Alist of commonly used
tools is provided for you
oK Cancel Environments... | << Hide Help Tool Help

AN 3.13 NMTATUIUT CHM AlsiLASadNa Raster Calculator

3.3.5 MIMTANARAMNEITBIAURNANULLANRDIANINFINGINS

NITATUIUNIAIANINGI VB AUANAINULLANABIANNGINTNH TnelEimAtianig
° o A~ T T S T ° ' P
ANUINLAILLATBIHD Zonal Statistics TatATaaletiiunisAuimnrgeganeluias 2
| 4 9/ dl (=3 ¥ o IS 09-// o d”
AT D4 AnTautenTadsiudnaNsoNauiulfannneals Inelduneual

1) g519qanNsuaessiudni tdainnisduliluniagauinaiuon 30 4n
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2) 4519 Buffer aanaindeyaqniinanangany 2 1uns taeldn
Geoprocessing > Buffer > Input Teak_Point > Distance Linear unit 2 meters (9NN 3.14)

Tneluseasdall 2 wastiaauanssnNaasdiudni lidoudaudounaainfuay

., Butfer - a] X

Input Features

Im‘ Point B =]
o

~ | Dissolve Field(s)
(optional)

Side Type (optional)

End Type (optional)

Method (opbonal)
PLAAR |
Dissolve Type (optional)
HONE
Dissobve Field(s) (optonal)

| FD
Clw

v

o Cancel | Emaronments... << Hide Help Toal Help

AN 3.14 N155149 Buffer

3) ¥INFATUIUIANAIINGITRIFUANANNULLATABIANNGINTINH (CHM)
meluFaf 2 wne o andautentesiiudn IneldmefianasAiuamkanieiasiie Zonal
Statistics ﬁﬁiﬁimﬂﬂ‘ﬁ ArcToolbox > Spatial Analyst Tool > Zonal > Zonal Statistics > Input
raster : Buffer_Teak > Zone field : FID > Input value raster : CHM > Output : L?ﬂ’aﬂﬁﬁu/m{i
8 > Statistics Type : MAXIMUM (3010 3.15) N199HANITATWIIUAIAINE99I1 L Tae 14

ATaaia Identify (FaNIN 3.16)

Input raster or feature
- I 2 zone data

Joos feid
FD

| ignare NoD ata m calc ulations (aptonal)

NN 3.15 MIATUIUUIAMNFIUDIAUANAELATRIND Zonal Statistics
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TEUATIHGS
Value
™ High: 20,5795

Low: 12,6764

5[]
A0} Locaton: [657,933.411 1,862,775.849 Meters |~
Field Value

Stretched value 182
Pixel value 18.814167

itified 1 feature

ok Caltdl'

NN 3.16 HANITATUIIAIANGIAILLATBIND Zonal Statistics

3.4 N3RS RTaYN
3.4.1 NMFAATISRANANNUETEUINIANNFIIRIAUANAINa N AWl FANTY
WAZAINEIUBIAUANAINNARUIN

va o K

e liAnAugeresfindnaindaganintien1aeiniAude §IReReineAIANgs

dl 1% a Ly 1 o 4 rd’ = o o o & ' 1 o
nlfndimsrzsimenanduiug aaiunis@nmseaumnuduiuszndnannugeessiugn
anaIniAgIuliAudl warANgIrasiudnaInnIAauINdnd A INdNRUs A uNINTlaY
Wele (FaaNnIg 3.1) T9N19LBNTEALIBIAMNANALF T as A AuLlszAnTandusinglu
nisuan winandntlscansandunusiandnlng -1 viva 1 uaasdenisiaruduiusiu

o 1 A 4 b4 = = o o & o o Y I S o o
seAUge uemnEAEnlng 0 Lassienasiianndniusiuluszauiien vsalulime 4 mFy

NIRRT ANE N2 aNSanANNUS tae ldnneinamnge 3.2 (Hinkle, 1998)

gl (dNNn15 3.1)
Xy — nx
. L xy —nxy
V2 (xi2 — nx2) /Y (yi% — ny?)
e n'= ANUIUFIBEIN

x = ANITRIFAUdNAINaIN ALUIEANTY
y = ANNEIBNAUANAINAIAAWN

L 12251 )

X = ANLBAEUBIAMLT X

¥ = Aadsuassauls y
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AN514 3.2 NN IENANTUITEALUIDIAMNANNUE

AT TLALABIANNANAUS
.90 - 1.00 HANANAUSIUgININ
70 -.90 HAuAnutiuluszALg
50-.70 HApuduusiuluszaulunan
.30 - .50 fpnuAuER U s AU
.00-.30 flaonudiusislusedunnunn

3.4.2 NMFATIAADUAMNYNADITENINNANGIVDIAURNAINDINALIULE
AUTL WAZAINGIUBIAUANAINNIARUIN
N1IAFIAADLAINYNFIBIIZUINAINGIRGudNAINaIN AR iE ALt LAz AN
v 4 d’ % ! A 4 9/ dgj dl o
gurasiiudnainnirauindayanirauinasliainnisguinensiudnnigluiui [a1usu 30
Fiv INEHNNNALATIZFANANINARALAREULAAYAIAI48Y (Root mean Squared Error, RMSE)
194ANNGBUANANe NIAEIU T AT ULATAYNGRFINANAINNIAAUIN ANGATAIUINL

ANAYINAANALARDLLRALNAIA 9 (ANN1T 3.2)

(dNng 3.2)

RMSE =

We = ATusaas
x = ANgITaAudnaInaIn e lEAudy

y = mmzﬂwmﬁuzﬁ”ﬂmnmﬂmmu

3.4.3 M3IATISRANANNUFIZUI NNV U AR UHIUAUEN AL NLIANLAZ A

garassudannlaanainiAeulEaudy

| 1

Walfnn1IngnasauANgnfiadssid A NgeTessiudnainainiAnulbaudy

ya o |

LazANgITessiudnannInauINuiatiu §adunudnangenliainainimaiuliaudy
dl 1% 09; ISP v [ o 3// ya oo R o0 1 &

uazANgIn liannIAauNTui A INELABNAUNIN AN A4ERINN1ANAY NGB

fndliandayganindianisainiaainainiaaiuliaudu andiasmeiniadudsy@ns

o o o I 2% 1 g = 4 4ﬂl % v
wmuwuﬁixmmmmzﬁumuquﬂﬂmqmemu@xmmzﬁwmmuﬁﬂwimmmmﬂmu%
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AUTU (ANN13 3.1) B9 lENUFTNIIRANTUNTLAL A NANAUS 91919 3.2 antiugase

u

fieanisiATziann1sannesatnede (Simple Regression) el lunnsnannsalaunnig

!
va o

dnuAuenanaienanaessiudn afadnlildllsunsy SPSS lunnsdasziannisnnnas
1 ' = :/, o d”
At dduneu Al
1) Bdindeygaruiatdueugudnansivasanaasfudnainnisasiui
NIAAUINLAZAINGIRARAN T LAaana Nt AraulEAud L IuTdsunsn SPSS aantiua%ng
A0 ANIIUUN (Descriptive Statistics) TaaldA1&9 Analyze > Descriptive Statistics >
. . (=3 1 1 v 1 1 ni/’ a dl Y & K 1A a
Descriptive... azLiiud1AIANNLTILa A AN TANTINAY 1 Fenans IiunsaaUnAves

da3a (11979 3.3)

A1579 3.3 AMRAUNARaTaYA

Descriptive Statistics

N Minimum  Maximum Mean Std. Deviation Skewness Kurtosis
Statistic Statistic Statistic Statistic Statistic Statistic Std. Error Statistic Std. Error
wuﬁmLﬁlllJ"lqukﬂnm\Jlﬂu 3o 13.85 44 56 238733 577337 1.486 A27 4628 .833
40N
ANUFIPBIAUAD 30 12.68 2058  17.2797 1.73371 - 655 427 428 833

Valid N (listwise) 30

2) menadevAlNalnArasdiayadan Box plot iivegdnfiudnsiuluuinien

¥

naUnfvesdaya IneldAde Graphs > Chart Builder > Choose From : Boxplot > ld%83/a
NFieINNInNazgn (AININ 3.17) aziiudsiudni 26 uaz 11 luliAlnUnfvesdieyaainnis
RTIRALIAY Box plot (AINTW 3.18)

#8 Chart Builder

| Variables: Chart preview uses example data
IGallerv‘ BasicElements GroupsiPointID Titles/Footnotes
- f ANUFIDDIAUTN [ 1-0 Boxpl BUAOLAUHA G I aIl...

EH0SE DIk UE R BTN,

Favorites ° o o0 Huav==13 & DB..

Bar é ﬂa ! [

Line @ * E ! H

Area Q [P

" H

Scatter/Dot

Histogram

High-Low

Boxplot _——

Dual Axes No catsggﬁ:}(scab

[ ok ][ paste |[ Reset |[cancel][ Help |

AN 3.17 N198519 Box plot




ANERN2DVAKEN

2200

2000

18.00

16.00

1400

12.00

1-D Boxplot of m’mﬁjmmﬁuﬂ'n

AR lﬁHH"IHFjHUﬂﬂ'W\J IWLNDT

50.00

4000

30.00

20.00

ANRALNGA

10.00

1-D Boxplot of 2L el Al HAKINAWIKEIDN

35

ISEREN
(o, 14

ANEALNG

N 4

NN 3.18 AMalnAvRTaya’INNITAFIARALAE Box plot

3) Nn1smRaARALING (Outlier case) TneldAd9 Data > Select Cases > If

condition is satisfied > If > sinANALUNARAN > Continue (AINIW 3.19)

o

|

%

o

23!

Eunctions and Special Variables:

@ Select Cases: If X
& amagipainudn [ Huav == 13 & DBH <= 40
& auadwinuduiin. +
&> Huav>=13 & DB..
Function group:
All =
: A
N /R IF0 R
G E E B CDF & Noncentral CDF
Conversion
aeE e S
Date Arithmetic
e e bete o

E)
(=]

elete

4) ulraunauatAnssaiun (Descriptive Statistics)

NN 3.19 AmFanisanARAUNA

1 o 1

AAUAAATNALNGILAZ

Halng axiiulddnan n insulasutilasann 30 mae 28 64 A1 Minimum luge

1 ¥ ! 4
fayaAHgIHANANTW A1 Maximum Mean wazAN Stb. Deviation HANNAAAINIIABIYA

=

aya dauAranNitivarAANTARILAlURATIAY 1 (FIR1919 3.4)
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A1919 3.4 LT U NEURDANTTUUINAUARNARALUNALAZURIAAATRALNH

Descriptive Statistics

' o 1 Aa a i e St i atin Skewne y nei

ﬂ’ﬂu@]ﬂﬂ"]&lﬂﬂﬂﬁl M Minimum Maximum Mean Std. Deviation Skewness Kurtosis
Statistic Statistic Statistic Statistic Statistic Statistic Std. Error Statistic Std. Error

nshe | Stalistic, | Std Emor | Statistic |

medwuguinmais . 1 30 1388 4456 238733 577337, 1486 , 427 . 4628 . 833

an ' P ' '

AN NI DA kD 1 30 : 12,68 2058 17.2797 1.73371 - 655 427 428 833

valid N (listwise) I 30,

o 1 > 5 ini i e Std. Deviatio Skewne urtosi

Maqmmﬂqwﬂﬂnm N Minimum Maximum Mean Std. Deviation Skewness Kurtosis
Statistic ~ Statistc  Statistic  Statistic Statistic Statistic | Std. Error  Statistic | Std. Error

2 AFRHIRFRD NAWIAD I g T g3 31.35 231014 439336 | 049 ! 441 a9 | 858

SR 1 1 I | | 1

A2 DA kD 1 og b 1436 1972 17.3261 1.427099 -531 441 - 671 858

valid N (listwise) I !

5) #1n1aNaeAN TN UAAIAINNANRUTTIAUA NUBIAIINGILRIFUANAN

' '
%

anAg Ul AnTULazau AdLR I uARTNaNgesenaasiudn TaalifAds Graphs >

Chart Builder > Choose From : Scatter/Dot > Int/ld483aA270g91295UANA N INALIY

Tsauduluunu x (Foutlsdase) warlddayarumEuninugudnaraiiasansassiudnluunu y

(FakUgmIn) AININ 3.20

R Li

35.00
G o °
Z 3000
1§ ]

L

= °
é ° °
T
5 2600 ° .
3 —
hd e ° °
= Y e e © O °
.g B e
WF VW[ g & -
c .
- L] L]
&

15.00

[ ]
10.00
14.00 15.00 16.00 17.00 18.00 19.00 20.00
AMNFIZDIAKAEN

MW 3.20 ANMNANNUE U UATIIRIANNGITRIAUANAINAMAE UL FAUTLLAS

TUALFUENUALEN AL NEIBNUBIAUAN
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6) MIVNADLNAAIANANNUE (Correlations) tnellEA&9 Analyza > Correlate

. . . 4 Y ! Ly = .
> Bivariate > Variables : TAT2HAAMNFILATTUIALAUNTUALINANNLNENAN > Correlation :

o & o

Pearson > OK aztiulfdnarugeasssiudnainainiaanulsauduiaauduiusiulu

'
o o =

uanivawaduEuguinaienanaessiudneteliidAnynisatiAnsedy 0.05

A1514 3.5 ASIARDUNBANEUANNUE (Correlations)

Correlations

UNALTUHL

ARDNATINAL ANAFIDIG
on win
'ﬂmmffu,d'mqjuﬂnmdlﬁu Pearson Correlation 1 ,3?4'
101 )
Sig. (2-tailed) 050
N 28 28
AMaguzaaaudn Pearson Correlation 374 1
Sig. (2-tailed) 050
N 28 28

* Correlation is significant atthe 0.05 level (2-tailed).

7)Hani19alAsITinAnas (Regression) AT TRET Y& Analyza >
Regression > Linear > Dependent : gadiaganringeaasfiudnainainidaiuliaudy >
Independent : gafiayau A& UENUARENATLNENAN > OK AINNANNTILATIZinADaE S
WU ﬁiﬁﬁuﬂizawfgwﬁuﬁuﬁ@wdwmwzgwmﬁuﬁﬂmemmL?aﬁumu@uﬁﬂmuﬁm@ﬂ
205UAN WAL 0.37 WA ANGITBUANANNTNeT LN BT AL BRI AN EIeN
1aafudnlasasas 14 (Fam1919 3.6) wazliannisannasasinadne FeanunrnesLnglEdn
ﬂﬁ?ﬁ’luﬁmﬂ"]ﬁmﬂizawé (Regression Coefficient) Imaﬁﬁ’]ﬁuﬂi:awaﬁrfuigﬁﬂaﬁU’m
ANNANNUTTIRIAILLT X LazFauls y Smualfiladeay I AsT 1ile x findw 1 wiiog y AL
wlasuutlasll b e (A9ANNNT 3.3)

Y-= 3.140+ 1.5612X (dNnng 3.3)

dl ¥ 1 s = o
LNB Y = BUALAUNIUAULNATLNENAN (G]’JLL?J?[?]’]N)

X = Arugantaainainiasuliaudy (Faulsbasy)



AN 3.6 NANISILASIETAADAS (Regression)

38

Regression

Variables Entered/Removed®

Variables Variables
Model Entered Removed Method
1 AMUFIVDIA . Enter
udn®

a. Dependent Variable:
2UIALHWHT WA RD NATIALID N

b. All requested variables entered.

Model Summary

Adjusted R Std. Error of
Madel R R Sguare Square the Estimate
1 3747 140 107 415128

a. Predictors: (Constant), aAnaguoasaudn

ANOVA?
Sum of
Model Squares df Mean Square F Sig.
1 Regression 73.082 1 73.082 4.241 050"
Residual 448.062 26 17.233
Total 521.143 27
a. Dependent Variable: ﬂuﬂmﬁuhi'lmjuﬂﬂmalﬁuqan
b. Predictors: (Constant), A agiaaJiaudn
Coefficients”
Standardized
Unstandardized Coefficients Coefficients
Model B Std. Error Beta t 5ig.
1 (Constant) 3.140 9,725 323 749
ﬂ")'wr-jdzndﬁua"n 1.1562 . 559 | 374 | 2.059 . 050

a. Dependent Variable: 2w e dwE RGUONA1IALBIDN
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3.4.4 n19UsLLNUUTNIUNIATIN TN R UANUAY wazn1sUsENIALT N

[ [~3 o
nasnninu m%uaummﬁuﬂn

[ %

nisdsziliudsninuoadonwnilanuauiiu §adealfvinisnnauedssasiy an

P4 % dl b % v o Vv 1 & = 4 o dl
mmqwmmmﬂwimmmmﬂmuvl,mumuLL@:mmmLmumu@ummqme@ﬂmmmum N

v
A A a

lAannisgusindnaiuan 30 fAu tialdlunisdsyilinEuinunadaninmileNuanuas

N

2 v v 1 v 1
o )

13217 AN TN NI NAL AT UAR B AUAN TUNUANIN A B9 1TUNUNAN I HAUIAN LN

a o KR )

dszann 4.416 13 Tu 119 Wdudnieznans 110 Ffu Wesansiudnindgniing §adaasinien

k2 v
vy o o

= dld v ° 4 o =K o dg’ dl & va o ¥
PWNANUNANEIATUAILATUINAUAN AN IHRNAUAN Iun UL ssune 486 Fiv an U Elllﬂ

u

24 o

o 1 ai (4 a = A dgl a tdl % ]
NINTWIALRALFARAYE AINN1TUILHULTNIUNIRTAIN WA U N LA Vliﬂ@qﬂﬂqﬁ‘@}l FUAN

A1 30 A AREANNITLAAIALET (TeTel, 2544) (AIENN1T 3.4)

W, =W, + Wy + W, (dNN19 3.4)

W, = 0.0271 DBH2Ht%9*35 R? = (.9915
W, = 0.0013 DBHZHt*1339 R2 = 0.8090

W, = 0.0205 DBH?Ht%6850 RZ = 0.8090

PeR W, = Naadannmitienufu (kg)
P
W, = 8aa@en w lugouansasi (kg)
W, = waadaninludauaesie (kg)
W, = wradaniwludouansly (kg)
DBH = Léumu@uﬂ‘ﬂmuﬁm@ﬂ (cm)

H = A ugeuassiuldl (m)

tsrunnarnieiniAuAfuaulugaudnanEui i aianIwi lé InesinaAFua
= dl ¥ v -2 09’ o 091 o % =
waTan i lfignudiae 0.5 GFasar 50 Tnatiuinaasminuiaaesnaadanan) (Margaret
et al. 2002)
C;= W, x0.5
(41N17 3.5)
Taed  C = AmFuauiniiu (kg)

W, = sadinnwinilaNunu (kg)
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3.5 ﬂ’]ﬁLﬂqﬁ‘ﬂNﬂ’J’]NW%’ﬂN
) ¥ 2 ¢ =9 L% o
3.5.1 ﬂ”l%‘Lﬁl‘a‘ElNﬂ’J']NW%"ﬂNdluﬂ”lu’Q‘lJﬂ‘im ﬁnmmmﬁmuvlsﬂumu

NaBTENAYNNTaNNBUENINNNIANEY AniufieadianIn AMNAINIID wazAY

' 1
a 4 o

o o - = = o A o o e
W?@Nsluﬂf]?slﬂﬂ‘ﬂﬂ?m sﬁx‘lmi‘ﬂﬂ‘]ﬂ’]'ﬂ@yj@‘lf}Lﬂf;l'm@\‘lﬂ‘i_lmﬂ’]ﬂmuvl@ﬂuﬂmLﬂuﬂ?ﬂﬂﬂmmﬂmﬂ‘

e

o ¥ LS [ o—dl 1% Y a dl a dsj 1%
VIWﬂ’JWNL‘HWI@IﬂQm@NUM N@@WﬁVIVLﬂ memm@mmwmmmmfaummmwm@%mmﬂm gl

q 9

o

AdldinnsAnwpaantfwaziiaddinlalunasdisduenisaulieudy Geeniaenu

P

TBaudunldlunnsdnen 8 3 uuy Ae 1) ernaAanulsaRdl 8%e Syma X5UW 720P Wifi 2)

anAsBIsANTY %8 SYMA X8PRO GPS 3) annadenulsaudy f%a DJI Phantom 4

Advanced (A9A194 3.7)

A5 3.7 annAagnulEaudunldlun1sAnsn

AR R WUANTIN/ATUANLTR

1 Syma X5UW 720P Wifi nAasANATYItUAn 720P

ANYAIUAN 2.4 Ghz.

s }irl*"" sveiziiulng 200 LWAT

& 1AIN7970U 10 U9

Bl Li-Po 3.7 V850 mah.

2 SYMA X8PRO GPS ﬂuﬂ@vaLﬂ?I“ﬂ\‘] 40X19 cm
e PAILANNTTTUGRE GPS
- & NABITUNA 720P Wifi
2 sreziiulng 200 Wwms

1AN130% 10 WA
= o o dl dl 1
TUAID A LN B LN ALLALABTEALS

WURATNSA 7.4V 2000 mah
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M54 3.7 (A|)

AR 3o uvaaTiay/ N
3 DJI Phantom 4 Advanced m’m@:lﬁﬂmmwﬁq : 20 Mega-Pixel
m?qlumm?i 2.4 2.483 GHz
] 3 SLUAMMUNANITEN GPS / GLONASS
® 2 ' Yiwnin 1,368 g WIALAES 6000 mah
g

w Qv R 1 J
NN 3.21 ‘VIﬂﬂ’ﬂ\‘l‘l.l\iﬂU’ﬂ’]ﬂ’]ﬁﬁl’]u‘lgﬂuﬂIU(a)LLﬁzﬂ mammﬂmwwumuﬁ'\aﬂmx

AAINTTNANENS (D)

3.5.2 naaadtdsaunaun1sdszuaaninann Agisoft PhotoScan Waz Pix4D Mapper

v
annsAnEAnaNT AR g uTeseIn AR AudukazinnastsAuen Aeuls

a o

o b4 X =2 ¥ o v o J d” dl o 1 dl v a 's
auduudaidpasifineraniaeuliaudulldanwiunsedaneldlunisneed
waznfFaumsunadnslunistszunananeulidnminunase anlilfidudiayanindiantg

va o K )

ANNNALR AU AT AL AAIN T ANARS UMANENREINIADT mmfumwmmmq
AdnansannianlE ldnaansilszunauadaalisunsy Agisoft PhotoScan Lag Pix4D
Mapper wiatiianuai i Bauieniuszming Agisoft PhotoScan WAz Pix4D Mapper
ANNTLFELAEUNLLN NAa18an13 Classification point cloud 9891151ln31 Pix4D Mapper

2
1 JAnuazidealazanNwuguInnduaanllsingu Agisoft PhotoScan
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3.5.3 neaaulFauiisuAianagerassulinuainlaanaimaeuliaudy

Adeldnnisasiundanngeresdinliluiinuaiudisanciainssuaians

e3¢

NUINNALULIALT Foandedinaaugasiuld (Haga hypsometer) A1uaw 10 Fiu (AININ
3.23) WatAANgen balFauiauduatangeantaainanniAewliaudun
szuaanaanniysunsu Agisoft PhotoScan kas Pix4D Mapper HaaWsh lEannn1s

WReUEUAIAYINgIeiuliAU A AN gandatna N AauBauduaearis 2 Tdsunsy

o

Wu91 ArANgeR laansszananamialilsingy Pix4D Mapper HuilAnln&LAseiu e

dl 1% d” -dlo/ & Yy 1% o $ 2 i a dl dl
V’]Q’]NQQVIVLWW]ﬂ@QWHV]QﬂF‘]uLLN@Qﬂﬂ@@ﬂrlﬂﬂ’mm%\'lmuiﬂ TAANAIANNNARNA LARDLLAAY

o

Anavaad (RMSE) iy +0.78 a3 dauataanugei tiainnislszunanasiaalilsunsu

Agisoft PhotoScan Ui ANANARIALARELRAEN1A9489 (RMSE) 1NAY +1.44 LWAT

o

st liiEpaaaaenldllsunsy Pix4D Mapper lunnsiscananan nlusnunAnmnass

Mw 3.22 sunissiuld(a)uazinanugeaulainanaasinanagasuli(b)



=)
N

un

NANTSIAE

anmsns i Banmnsinifuaiueuiatenniewaudy luaniui fua
Junueu anedaned Aadaienilan uivnanissgeantdy 4 dau il

4.1 nsasdeyanimaigainainiAeulFaudy

4.2 AIRRBUALINDNFABITEUINIANNASLRAUdNAINeIN AL EALTY uazAX
ArB9AUANANAIARUIN

4.3 prrndusiugssndnaunadud wAugnat N ENeNLa YA NG BIF UANAIN
anAenulEaudy

4.4 dsziutBunminaadannnilafiuiu uaznistszanmaniunmnsinidu
ANFLIAUDIAUAN
4.1 NMSASNTAYRNMNINENINBINIAINDINIA LS AN

4.1.1 wanisUssuIana W

ann1siiudasauaztranwsaaaniaenulipuduugie azlideyaninaianis
a1nAaNaINIARlEANTL 41U 90 N m@m@uﬁ”uﬁ 0,069 msilawms el
szananasienszuaunis i inunsnmszenullsunsn PixdD Mapper Aazl@ifluiuuanans
mmuzgq'zaﬁ'qﬂﬂﬂquﬁ”uﬁqﬁm,@m ( Digital Surface Model, DSM) (AN 4.2) LULANA89ARNN
guniilszinAmaia ( Digital Elevation Model, DEM)/ (Digital Terrain Model, DTM) (A90%

4.3) WHUNAINEIENI9BINA (Orthophoto) (NN 4) LAZLLLRNA8IATNER (3D model)

(AININ 4.5)

NN 4.1 mwdwmqmmﬁﬁ"lﬁmnmsﬁuﬁﬁswﬁmmm ﬁmu"l,"a"ﬂwﬁ'u



44

.a"'-"j EI
r{.lt'i"p-

- M dsmutif
gl PI F
H

Value
H _a,;;' l High : 60.9815

S\ eters.
0510 20 30 40

] , “:—. Low 1222732

* 1'. P
1) L\, T - i3
I:I|:':!l, E:i' “' }f’_ "‘-\::ﬂl } _. £ _JA!E\? f | A‘f‘ llﬂ.ju
\ :H___jqﬂ'l’ﬁ 42Ltuu ammmﬁgﬂnﬁagw mﬁﬁq
1'.";“':"";.
%
L 4\
N
- \

GRIE
Copyrig

DT™

Value
™ High:44.4

Ity

N

Meters

O —
0510 20 30 40

Low: 13.165

NN 4.3 LUUdNaaIANNgandlseinAEaa (DTM)



chm

Value
™ High: 25.8588

0510 20 30 40

Low : -28.3005 q ﬂ’ﬁ' CaC—w— Meters

Ortho
RGB

M Red: Band_1

H Green: Band_2

M Elue: Band_3

b * v

S \eters
0510 20 30 40

2N 4.5 Mwaeaaslaaliaiaa (Orthophoto)



DSM

DTM

CHM

NN 4.6 WUU[NRRIRINAR DSM, DTM, CHM waz Orthophoto
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4.1.2 MIMTBYAANNFIVBIAUANANUULINADIANMNFINTINA

ANAINNGITRIAUANAINUL LA ABIANNGINTeNnT IFananAeuliaudy Tng

q

nsldmAiaAnNsATWIAALLATENEE Zonal Statistics T9ATUIINIANGIgANTE TWTAN 2
= v dl < % s o dl Y o

INAT W AAEFaUnanTeIfuANNa N TaNaiulAn wealan (Aann 4.7) WalfAiaangs

Yasfudnatna N AL lEALTURS 30 Hulda (AIA1379 4.1) AsianldAmsziunAniaas

ANNAANALAABULTAAA NN LFANAIAAWIN . LATIZTANIHANTUTIEUINNA NG
Y 1 Cy = ¥ o a = A d’l a a

LA AU AEUENWALENATI N ENENIBIAUAN UssiduNaaTIn Nmle WAy UseiluFunn

NNIANALANTLRNIAUAN ATNANALNATBINITATUITUAIAIINGNTBIAUANAINULLAIADY

AVTHGINTINH (CHM) IHaRRIUN AR Profile Graph Tultlsunau ArcGIS wud1Aau

& o dl 1% 09; ! 1% ¥ = dl ! 4 o 1 ¥ 1 3
geraAndn i Tudasdnuniinaouarinonuganuannda siudnlugesiinaaouasnaiu

Y o [ ! 1 o (=3 ! 1 dl ¥ a d} dl
1@?@ (MINN 4.8) A1 LU TN EMINNEIY %mLﬂmmumm\‘lmm@;\mimuu HDWNUUIN

ANAYINAIAININ B1aaziinanFudn luiunsnaiulii (dann 4.9)

ol

Value
™ High: 19.9591

Low : 12.4508

NN 4.7 MSATUIUAIAIINEIAIE Zonal statistics
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Profile Graph Title

Profile Graph Title

I

o . A .
o [

vy

LI CIL A WP AV LY

010

200 3 40 50 680 70

Frofile Graph Subtitle

oy

. Veters
0510 20 30 40

2N 4.8 AMNFIUDIAURNAINNINAATINAINAIUNUIRIUTIPIUUAIAIU

Profile Graph Title H
Profile Graph Title
15 MA‘Y/_‘_\WWA W”\Tﬁ/‘/\"\ﬂvﬂvf\ y
0 / i
: / "
0 5 10 15 / 20 25 3 35 a0
Frofile Graph Subtitie

e Meters
0510 20 30 40

NN 4.9 mwgwmﬁuﬁnmnmwﬁmme (WIA2NY)
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A58 4.1 ANGITRIAURNAINaINIAEIUISAuTUN AR NNISEN A1UI 30 61U

B CHM B CHM
1 16.68 16 15.07
2 18.27 17 19.72
3 18.78 18 17.10
4 16.58 19 17.52
5 18.08 20 18.81
6 17.85 21 15.67
7 18.39 20 18.21
8 17,94 23 16.80
9 16.55 24 14.56
10 18.31 25 19.24
11 20.58 26 12.68
12 18.62 07 15.46
13 17.75 28 14.61
14 16.84 29 15.25
15 18.33 30 18.14

4.2 RFIAADUANNYNADITEUINANNGIVBIAUANAINDINIAEIUTEANTL uazAN
FAUDIAUANAINNIARUIN

ANNNIIATIREDLAYINYNFIBIITNINANNGITassiudnaneantAeuliaudy uas

AIINAIUBIAUANAINNIAAUIN L NUFIAFTNANNUFIENTNANNGITDIAUANAINDINA

'
o =

aaulbaudu uararnguesfiudnainninauin e uduiuiiulae? R windu 0.97

AMNUUUININATIZFANANNARIALARDLLRALNNA9A8a (Root mean Squared Error, RMSE)

o

(AIA1979 4.2) Ta9ANGISUANaINanIAenulEAuTILAZAINgIIasSudNAINAIAALIN

[

HAAWENLARAE AN RMSE A1naunIs 3.2 1a9A2ugasiudnainainiaa ulbaudiiuazainy
AIAUANAINNITAINUANIAGUIN WINAL +0.51 LUAT TIAINITOUAAIAINANN LTI
ANgRassiudnananIAeultaudy uazaNgaassiudnanaiaaunlugtuuunsan

(AN 4.10)
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MARUIN
AMNEIUDIAURN  ANFIUDIAUAN . L.
AUN MR  KAANMIAIAEY
(MAFUIN) (mmﬁmu‘l%'ﬂwﬁ'u)
1 16.50 16.68 -0.18 0.03
2 19.00 o 0.73 0.53
3 19.00 18.78 0.22 0.05
4 17.00 16.58 0.42 0.18
5 18.50 18.08 0.42 0.18
6 18.00 17.85 0.15 0.02
7 19.00 18.39 0.61 0.37
8 17.50 17.94 -0.44 0.19
9 17.00 16.55 0.45 0.20
10 19.00 18.31 0.69 0.48
11 20.00 20.58 -0.58 0.34
12 19.00 18.62 0.38 0.15
13 17.50 17.75 -0.25 0.06
14 17.50 16.84 0.66 0.44
15 18.60 18.33 0.27 0.07
16 16.00 16.07 0.93 0.86
17 19.40 19.72 -0.32 0.10
18 17.50 “ya 1) 0.40 0.16
19 18.00 17.52 0.48 0.23
20 19.50 18.81 0.69 0.47
21 16.00 15.67 0.33 0.11
22 19.00 18.21 0.79 0.62
23 17.50 16.80 0.70 0.50
24 156.00 14.56 0.44 0.20
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71579 4.2 ()

AUN

ANNEIUDIAURN  ATNFIUDIAUAN , L
NARN HARNNNNAIADY

(NMAFUIN) (mn'mmu"l.%’ﬂuﬁ’u)
25 20.00 19.24 0.76 0.58
26 13.00 12.68 0.32 0.10
27 16.00 15.46 0.54 0.29
28 14.50 14.61 -0.11 0.01
29 15.00 15.25 -0.25 0.06
30 17.70 18.14 -0.44 0.19
599 7.78
awé’mﬁuﬁ‘ismwmmgwaaéfué’n (UAV) uag A18geuas
AUFN (NAFUIY)

=

% 25.00

T

&

c

& 20,00 o ®

"

8=

£  15.00

@

& R = 0.97

% 10.00

c 10.00 15.00 20.00 25.00

ANUGIBIUAN (UAV)

NN 4.10 mﬁNﬁuﬁuéewdwmwgwmﬁuﬁn
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4.3 AMNANAUATENIN U AR UNIUAUENA NN ERANUASANNFITBISUFNATN
anAs U S ANy

AINNNIANHINLFIAINANRLT TN TR AE W UARTN AR ENBN LAY A TN

1 9/ P o Ay % 1 4 A & dl dld a a
m@amuzﬁﬂmﬂmmﬁmuimmu NUINNAUANDE 2 AU AR AU 11UAT26 NUANNEALNR

I ' o =

AYNANRUTITNINTUI ALE W UARTN AN ENNUAT AT NG AJUANFNIaINFUAN S

U

' v
A o ! [

a1 7 A uINTR SIUANNGNN1IIINA 30 Siu Tunaadiagnziun ANANTUE sz NI TUA

q

¥ 1 Cy = b4 o P2 o ya o Y v a 1
Lﬂum'ﬁu@]uﬂﬂ@’]\‘lL‘WEI\‘l'ﬂﬂLL@%ﬂQWNQQﬂ@Qmu@ﬂ@Wﬂﬂ’m’]ﬁﬁl’]u1ﬁ‘ﬂu°ﬂu QQ@H1®W@@M1@1N

o 4 % o 1 ng/, A 2 g o o 1 ¥ 1 e
mLmmuaﬂm\‘mmquﬂﬂiﬂummLﬂmwm ANANNUTTLNINAUNA AURNIUAULNATY

v v
N o o

EIDNUATANINGI1RAUAN INEAAAIAITNARIALAREULBIAIINANTUET AdtiunanIs

Ly o o '8

ATz ANRUSsTndsTuIAEuR IR AR N A N NLazAINgIT B WAN HiAY

o
v o & 1 o & o

AutlazANBANANNUS WinfU 0.374 Apnuduiusiulumauan HAudunusiulusesumn

TINAIMNIRADS a = 3.140 WAL b = 1.152 (FanIw 4.9)

3500
& e ©
3 30.00
iz ® L]
; . . .
T
a% 25.00 ° .—
§> ° . s © R
) e °
.5 B ] b °
,% 20,00 . 8 -
§ »
3 < | . R = 0.374
15.00
®
Y =3.140 + 1.152X
10,00
14.00 1500 16.00 17.00 18.00 19.00 20,00
AN ZDAKEN

MW 4.11 ANNANNUETEUINAMNFIUDIAURNUASVUIALAURIUAUENAI WL
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a ‘e a 1 (v <
4.4 Uszinudsunmnadon iwuntanuau waznisdszunaeaidsunainisnnunu
ANSUAUTRIAUAN

v [
o

AINNTANHINLIN NUNauaRauou 4.416 19 Tu 1 19 FAudnilezunn 110 fu

v
o o

WA uEUAN NN aquAn IR WIULTZHNUL 486 Fu Teaz lFL NN NIaTININITe
d” a dl 1 v 1 % a %3 o 2; a A di/ a dy dl o :j

NuALRALFAAL WAL 353.88 NlaNTN AIULNIATININIUENUAL IUNWNAIURNINLA
Winiu 171,985.68 Alansy asnalédiEuanin1sdntAuAIsuauaadgiudnil sy
85,992.84 Nlaniu uazAnuaintsnlunisgaduintafusulaaanladasudnil windu

31,533.57 dlansumail

A19149 4.3 UFNIUNIATIMWRUAN LAY

AINFITRY Y uraTaAWLATaNUAY
. B T AUIALAUHIU
AT AUAN | ) S "
=0 AUENRINWEIDN AR (kg) N3 (kg) Tu (kg) 994 (kg)

1 16.68 28.01 302.61 24.81 110.59 438.01
2 8.2/ 28.49 341.04 28.45 121.74 491.22
3 18.78 25.15 272.61 22.86 96.63 392.10
4 16.58 22.50 194.14 16.90 71.06 281.10
5 18.08 27.37 Sile® 2 25.95 111.58 449.25
6 17.85 21.93 197.69 16.42 71.00 285.10
7 18.39 22.25 209.33 17.48 74.59 301.41
8 17.94 25.08 259.82 21.60 93.19 374.60
9 16.55 21.562 177.26 14.51 64.91 256.68
10 18.31 19.58 161.34 13.46 q7 &6 232.36
11 20.58 44.56 933.57 79.65 323.15 1336.38
12 18.62 31.35 420.41 356.19 149.35 604.95
13 17.75 23.11 218.40 18.12 78.54 315.05
14 16.84 19.74 1561.52 12.44 55.24 219.20
15 18.33 23.46 231.92 19.36 82.72 333.99
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ﬂ')'lN‘Zﬂ\?‘ll'ﬂ\?

NARTINTWLAUBNUAY

v 4 . e YUNALFUKU
AUN AWAN R - . s -
(UAV) Auananawedan  atau (kg) N9 (kg) Ty (kg) 99U (kg)

16 15.07 22.28 173.97 13.99 65.27 253.23
17 19.72 22.44 227.39 19.24 79.58 326.22
18 17.10 13.85 75.69 6.23 27.48 109.41
19 17.562 16.93 115.79 9.58 41.79 167.15
20 18.81 25.18 273.84 22.97 97.01 393.82
21 15.67 23.24 196.27 15.90 72.90 285.06
22 18.21 31.04 403.45 33.63 144.14 581.22
23 16.80 19.35 145.37 11.93 53.03 210.33
24 14.56 27.82 262.47 20.97 99.36 382.79
25 19.24 28.87 367.76 30.98 129.53 528.26
26 12.68 24.80 182.99 14.24 71.79 269.01
27 15.46 17.28 107.25 8.67 39.97 155.88
28 14.61 17.00 98.29 7.86 37.18 143.32
29 15.25 19.74 137.99 11.12 51.61 200.73
30 18.14 22.28 207.22 17.26 74.10 298.58

mgﬂ 17.28 23.87 245.30 20.36 88.22 353.88
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o o a = = v v 1] = | o o & | [
nas Sandnnentlan Gennsdne tddatinldnnasunArpnduiuisrudeacngeeesiv
o dna o~ (A s s : ¢ o e
dnilFaineinipeuliauduiuAiAugenlFaannnsasiunaInauIN LazANANANTLE

£ideANgeaafiudn liainaniAeuliauduiazauindulaududnanaiissanaes

'
% o A

AN WAMIAINIATIN INNLA N UANLA L TN NALAITUALABNAUAN TeagLng

Y o

=S d’j
nNgANE LAAatl

5.1 HAUDNNFMAUANNUFIEUINANNGIIRIAUANANa AL ULEAUTY was
ANFIURNAUANAINNARUIN

HANII AN ALIANANRUT T T A NgaRAudNaIna N A EAudy uas
AYIHANTBIARANAINNIARUINTU WUIINITUANTEAUBIANNANNUF Y aldAn
AutlsrAvdavduiug unisuenandniug wnatdudscansanduinsiadn1ng -1 vise

=2 = o o o o o ! ISP 4 % =<K = 9 o o o
1 UAANDNNITHAINANAUE T UITALAY WiIndA NG 0 wanedan1sRANdNriugiuly

svaitiae visalidiae Blans iuIna AN RUETe N A NgeaBsfudNaINaI NI ALY

= o o o &

v 1
Baudy tazAugerasfiudnannaInauINtu dseauanuduiusiuganin tnaisi R

WINAY 0.97 a1NN1TNANTNANENL 22 Anaandunus taeldinaiaiaaa Hinkle, 1998 A4

'
a o

Adl o 09: o ¥ v dl ql/ Y o1 & o Ay y v o ISP
AT 3.2 muumimmm‘ﬁ@uuim ﬁmm@jwmmu@ﬂmimﬂﬂmmﬂmuimum AN

4

IndpasiuAugeassiudnannipsun uszAunaaniuls

5.2 HaINNITATIAFRU ATHNEN ﬁmizwiwﬂ'nugwmﬁuﬁ'ﬂmnmmﬁmuﬁﬂuﬂ'ﬂ

WAZANGIIBIAURNANNIARUIN
HATRINIIFIIAADLANNNYNFIBITENINIANGassi udnana N AanuBaudunay

ATHNAITBIAUANANNNIAAUIN NUTIAIAIINAAIALAADUIAALNIAIADY (Root mean

b %

Squared Error, rRuse) 2849A1437 IHanainiasuliauduuazaanganliainninaus

IR = = ' ' ) Y o any
WU WA +£0.51 LURAT sﬁ\'iLL@@\TQQWQWNLLmﬂm’]\ﬁ‘gﬁuqq\?ﬂ’]ﬂqqﬁ'@ﬂﬂ@\?mu@ﬂm1ﬂ@qﬂ’ﬂ’1ﬂqﬁﬂ’]u
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Tsauduuazripangaaefiudnannisivdeyaninauis InefiA1ANgeaR9iugnaIn

an e uliauiuiuiA InfipssiuAIAINgaessiudna INAIAaUIN £0.51 lwRs

5.3 HANNFILATISRANANNUETEUINNUUIALFUHNUAUEN AU NEIANUASAINFIUDY
Y o ay v v o
pudnilaainainiAenulsaudy
HATBINIIILAIN L HANANAUTE UMW ALE LN UALETNANNEIBN LA A TNGITD
2 o dl % P4 o AJ 14 I 4 o
fudnilFanannaAaulbaudy F9ann19a99R@eUAINGNFHB9TEUI1NA NGRS UAN
v
ananAsIRliANdl uazANgaaesfiudnaInnaAauINtl §ade lHinienAANgITes
4 o tzll b % 4 ! v o a Ly 1 o a n:r
fudnnldaindeyanandianiveiniAaineiniasuBeaudy udinsziviaduilscans
andninfaznd NIB A B uALINANRNeN wazANgITeBiudny liananiAauls
ABTU N19UBNILALIRIANNANNUTUUN axldAduss@nsaudunuslunisuan
o o & b s a ar o o oAl 4 b % A = = o o 6 o
ANANNUST UINANENLLANTANANNUSHANINING -1 1178 1 UARIDINITHANANNUTAY
srALg usiiandAdinlng 0 uansdantsiaudninsiulussaulion visalidian Tauans

MmN AN Rus sz AU IWANENA 1N ESBNULAZ A NGI 18 Audn T lFan

D

o-

o

v [ ug// = [ & o a = o o & o o dl =
anN1ALIUIEAUTUTY JAuduiusiuludsunn wariaouduiusiulusesuni 1ai
ATNITIRLAAS a =3.140 hay b=1.152 Ipae1 RLVNAU 0.374 a1nN13RA1 T AN
Auilsr@vsanduriug loalfinnusizes Hinkle m1ua1979% 3.2 AWiLERSERMIN19RIIad0L
PIATANHARIALAAAULARLNIAIADIAT WUTIATAITNLANAINTENINUUIALEUN Y
ARTNAIANENEN LazAIAINGInassiudnanaInIAsuliaudy AA AR ALARELIRAE
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Abstract

This research is a study of photogrammetry techniques from unmanned aerial
vehicles to assess the amount of carbon sequestration from the teak area. The correlation
between the height of teak trees from unmanned airplanes and the height of teak trees
was investigated in Wangthong district, Phitsanulok to estimate the amount of carbon
sequestration from the plantation area. The accuracy between the height of teak from
unmanned aircraft and the height of teak from the field. And to estimated the diameter of
the chest using height data from the DSM, DEM, Orthophoto, and 3D models. The results
of aerial photos from unmanned aircraft found that the relationship between the height of
the teak from the unmanned aircraft and the height of the teak from the field has show well
correlation. The correlation coefficient was 0.97 and the mean square error (RMSE) of the
unmanned aerial altitude and field height was + 0.51 m. Tactile has an above ground
biomass of about 171,985.68 kg and a carbon capture capacity of 85,992.84 kg. This
plantation is also capable of absorbing carbon dioxide approximately 31,533.57 kilograms
per year.

Keywords : UAV, Teak, Biomass, Carbon
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